TECHNICAL NOTES

November 5, 2012
MO-1 Technical Note Number 49

Re: NASIS - Importing NASIS data into MS Excel

Software used to make this technical note:
e Windows XP operating system
¢ NASIS 6.2
e Microsoft Excel 2007

[ ]
This technical note provides guidance in
e The three options for running reports in NASIS

e How to import NASIS 6.x data into MS Excel using NASIS export reports

e How to copy and paste data from NASIS into MS Excel

Notes:

¢ Many NASIS reports are written specifically for the purpose of creating a delimited text file
that can be imported into spreadsheet or database software.

e These NASIS reports usually have the word “Export” or “Data Dump” in the report name.
Data fields are generally delimited by either the pipe symbol (]) or colon (:).
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Three Options for Running NASIS 6.x Reports

1. Run Against Local Database

This is the option you will choose in most instances
Only runs against data in your selected set
Doesn’t run against all of the data in your local database
No parameter necessary
Output is stored in C:\Documents and Settings\All Users\Application
Data\USDA\NRCS\ITS\Nasis6.x\Temp
= This is a protected folder and the reports are replaced every time you run a
new version
= |f you wish to save a report, you will need to save it in a different
location

©Oo0oo0o0Oo

2. Run Against National Database

0 Only used with reports that include a parameter or are coded to limit the results
0 Reports that don't restrict the number of records in the output will run on the entire
national database
o0 Output is stored in C:\Documents and Settings\All Users\Application
Data\USDA\NRCS\ITS\Nasis6.x\Temp
= This is protected folder and the reports are replaced every time you run a new
version
= |f you wish to save a report, you will need to save it in a different location

3. Run Offline Against National Database

Only used with reports that include a parameter or are coded to limit the results

¢ Reports that don't restrict the number of records in the output will run on the entire
national database

e This option allows you to continue working in NASIS while the report runs offline
against the national database

e Output is placed on the NASIS server and link to the report is emailed to you

What is a Parameter?

Parameters are fields that allow a user to select certain records from the database. For example,
the following report has a parameter that allows the user to choose the map unit NASIS group prior
to running the report. This means you can run it against the national database and only receive
records that have a certain map unit NASIS group.

E{_n‘j ExXPORT - Mapunit data dump by NASIS group

Below is what you see when you run the report against the national database.
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Selections for Running Report EXPORT - Mapunit data dump by NASIS group

I Mapunit MASIS Group {eq 1-3 Saler, Oregon or 1-3 Mounk™): |1_5 Redmond, Oragon | Run
il
esCHpEon: This expott report will generate a pipe - |

Cancel
delimited txt file containg about 100 data
elements.

The report will prompt the user ko enter & LI

Parameter

Repart: 1 FARAMETER Mapunitgrol <
2! BASE TAELE component;

3! v
| | 3

Instructions for Importing NASIS Reports Into Excel

1.

Run a NASIS Export Report.
¢ In this example | have loaded the JODA soil survey into my selected set and | will run the

MLRAO1_Office report called “EXPORT — Component ecological site & other veg class”
against my local database

e ——

W' % View Ready to Use Orly

I <E0%iew Checked Dut Only

[=H 7 Favorites

E{& I1SDIR. Mapunit daka dump by MASIS group - EXPORT
E{"} CHECEK - Canopy cover and existing plants - musym sort
];’_rj CHECK - Hotizon fragments, texture, sigves (comp sark)
]:5 CHECK - Hotizon R skructure and texbure (comp sark)
E{& CHECK - Physical properties (component sork)

E{"} CHECEK - Temperature moisture classes, climate

];’_rj CORR - Mapunits by Mame

]:5 ExXPORT - Comp legend wi local phase, surf bexture
E{& E¥PORT - Camp vegetation and climate carrelation daka 2
Eﬁ EXPORT - Component ecological site 2 other veg class

O FYvpep T oot golonical site feotber ven, flass 2
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_'rﬁEEXF'ORT - Component ecological site & other veg plass |I” " |
| EXPORT - Component ecological site & other veq. (2l Open Chel+5hift+0
i, ) )

EXPORT - (3 hic dat th MLRA

; EOmarpHic gata $  checkout Ctrl+ShiFt-+K
¥ EXPORT - Mapunit data dump by MASIS group

| : :
_'rﬁ MG - Mapunit description v, 2.1 (Ksat class rang Mark For Deletion Ctri+hift-+4
_rf.“ PEDGM - Pedon Desc {engl) wiFormat & unformat| ) Femove Deletion Mark Chrl+Shif -+
} 555 - State Cumulative Progress by Acreage Cakg Discard Changes
ﬁ UTIL - Compatison of Concrete Carrosion, skar ws check In Chrl4-5hift-+1

[
_'rﬁ UTIL - Comparison of H5G, stored vs calculated | 0 view Chack Out Stat Ctrlsshiftec

: +Shift+
_rf.“ IITIL - Comparison of K Factor, stored vws calculats B VIEW TSR LA St ' I
_rf.“ UTIL - Comparison of Steel Corrosion, stored ws, | P Run Against Local Database Ckrl4+Shift+L
s _ .
7 UTIL - Comparison of T Factar, stored ws caloulat W Run Against National Database Chrl4-Shift-Hh
_'rﬁ UTIL - Comparison of WEGMWEI, stored ws calculs
. . F  FRun Offline Against Mational Database Ctrl+-Shift+R
% UTIL - Legend area overlap and mapunit overlap
% UTIL - Query Mames by location @ view Information Chrl+Shift+H
ﬁ TIL - Report Mames by locakion _ _
55C Pangasa Add to Favarites Ctrl+Shift-+F
-cal Plant ™, Remove from Favorites Ctrl+Shifk-+HF
—

2. The report opens as a txt file in Notepad (unless you have changed the settings on your

computer so all reports open in Microsoft Word by default).

Notice the pipe delimited fields.

!l. EXPORT - Comp. ‘nent ecological site & other veq class.txt - MNotepad

File Edit Format =y Help

Close this file after it opens.

=0l x|

J0DA
J0ODA
a0DaA,
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0ODA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0ODA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA
J0DA

d

nitial
Initial
nitial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
Initial
nitial
nitial

12

124F
125E
126G
127E
147E
148C
1480
149E
314E
349D
351E
352E
352F
353D
354D
358C
358D
350D
1020
1404
362E

4488477 |Monroe clay, 0 to 3 $ercent sTopes|Beeman| | 8| No| 88477 :132153]2

3334
203C
203D
124D
1:24F
125E
127E

88506
BB507
38508
BB5009
38511
88512
38524
88525
38326
88527
BB541
38547
88548
385409
BB550
38551
88552
38555
38539
BB557
38482
88510
38540

38537
88530
38531
88507
38508
38509
88512

Twickenham-Day-Badland complex, 15 to 30 percent south slopes|Badland]
Gooserock-Brishois-Badland complex, 15 to 40 percent north slopes|Bad]
Gooserock-grisbois-gadland complex, &0 to 90 percent north sTopes|Bad]
Drinkwater-grishois-gadland complex, 30 to 60 percent south slopes|Bad
Badland, &0 to 120 percent slopes|Badland||85|ves|88511:132274 |150] ]|
Brisbois-badland complex, 20 to 50 percent slopes|Badland||30|ves|8851
Sorf-grishois-gadland complex, 30 to 60 percent south sTopes|Badland]||
Simas-Brishoizs-gadland complex, 2 to 15 percent slopes|Badland]||20|ves
Simas-Brishois-Badland complex, 15 to 30 percent north slopes|Badland|
Brishois-gadland-simas complex, 20 to 50 percent north slopes|Badland]|
Twickenham-Badland complex, 20 to 50 percent south slopes|Badland]||20]
Simas-gadland complex, 15 to 40 percent north slopes|Badland| |40|ves|8
Twickenham-gadland complex, Tow elevation, 20 to 50 percent south slop
Badland-Day comﬁ1ex, 2 to 45 percent slopes|Badland]||45]ves|5885459:1324
Badland-Twickenham complex, 30 to %0 percent slopes|Badland||65]|ves|38
Sorf-gadland complex, 15 to 40 percent north slopes|Badland| [40|ves |88
sorf-gadland complex, 15 to 40 percent south slopes|Badland]||[35]ves|88
Simas-Day complex, 3 to 15 percent slopes|Badland| |10|No|88555:132455|
Simas-bay complex, 15 to 40 percent north slopes|Badland||10|No|88539:
Simas—DaE complex, 15 to 40 percent south sTlopes|Badland||10[nNo|88557:
Gooserock-brinkwater-gakeoven complex, 15 to 40 percent slopes|Bakeove

MO

To

|l

Area SymeWILegsﬁd StatuslMaEunit Symbol [Mapunit Key|Mapunit Name|Component Mame|Local Phase|C a
1:

ruckles wery cobbly loam, 0 to 3 percent slopes|Bakeoven||7|No|B88515:1
Barbermill-Mitchtown-Meadowridge complex, 30 Lo &0 percent s ?? IBarb
Beeman s11ty clay loam, 0 to 2 percent slopes|Beeman||85|ves|88537:
Bingville very cobbly loam, 2 to 15 percent slopes|Bingville]| |85]ves|8
Bingville wery cobbly Toam, 15 to 30 percent north slopes|Bingwille| |8
Gooserock-Brishois-Badland complex, 15 to 40 percent north slopes|Bris
Gooserock-Brishois-Badland complex, 60 to %0 percent north slopes|Bris
prinkwater-erishois-Badland complex, 30 to &0 percent south slopes|EBri
Brisbois-badland complex, 20 to 50 percent slopes|Brishbois|sout |25|ij:J

| H

i
? 132
1




MO-1 Technical Note Number 49 — NASIS - Importing NASIS data into MS Excel 11/5/2012

3. Start MS Excel Click File > Open and browse to your export report which is stored in C:
\Documents and Settings\All Users\Application Data\USDA\NRCS\ITS\Nasis6.x\Temp
e | recommend making a shortcut to this folder
¢ You will need to change your “File of type” to All Files (*,*)

Lok i I“j Temp j @ - X -
| Recent
@' Deskkop

an

Documents

3
Compukter

"_J Iy Metwark,
Flaces

File anne: :I
Files of bype; lacChadts * xlsacy * xlsmy * . xlshy *odam; *,xdbsg *odbmy *.xds; *.dk; * bty *,html; *.mht) +

FY

T s Foxlsmy *dsh; *oxdamy * kg * by *xls; * oty * Remg * html; * mb T |
Tools |~ Excel Files (*.x1*; * xlsx; *,xlsm; *.xlsh; * =lam; * =k * ozl *xls; * xla; *xlky *, g *xdw) ance

|All eb Pages (*.htm; * html; *.mhbt; *.mhtml) £

NOTES:
e If you run a report offline against the national database, you will receive an e-mail with a link
to your report. You will need to save this report on your computer
e If you are using Windows 7, the report file will be stored in
C:\ProgramData\USDA\NRCS\ITS\Nasis6.x\Temp

4. The following Text Import Wizard will appear after you open your report
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Text Import Wizard - Step 1 of 3

21

11/5/2012

The Text Wizard has determined that vour data is Fixed Width,

Click Delimited and then click Next

IF this is correct, choose Mext, or choose the data tvpe that best descri aka,

riginal data bype
Choose the File bype that best e your data;
aracters such as commas or tabs separate each field,

" Fixed width

- Fields are aligned in columns with spaces between each Field.

Start import at row: |1 E‘ File origin:

| 437 : OEM United States

Preview of file C:\Documents and Settin, . \EXPORT - Compaonent ecalogical site & other veq class.txt,

Rrea Symbhol|Legend Status |[Mapunit Symbol [Mapunit Hey |Mapunit MName | Compor
ODA | Initial | 1230 | 28506 | Twickenham-Day-Badland complex, 15 to 30 percent
MODA| ITnitial | 124D | 28507 | Gooserock-Brishois-Badland complex, 15 to 40 per
MODA| Initial | 1E4F | 823508 | Gooserock-Erisbois-Badland complex, &0 to 30 per
MODA| Initial | LESE | 28500 | Drinkwater-Brisbois-Badland complex,

30 Lo &0 pelw

IA n [ D e [

[

Cancel

= Back | Mext = I

»

Finish

Text Inmmport Wi

21X

This screen leks vou set the delimiters wour data contains, ¥ou can see how waur kext is affected in the preview

below,

~Delirmiters

[T 1ab

[ Semicolon ™ Treat consecutive delimiters as one

[T Comma

Text gualifier;
| Space

" [

v Cther: II—

Uncheck “Tab” and place a |
character in the box to the right of

“Other”.
~Daka preview

Click Next
rea Symwbol Legend Status Mapunit Symbol Papunit Eey Papunit Name -
oA nitial zah gBE0G wickenham-Tay—-Badlan
ODnA nitial 4D gE07 ooserock-Brishoi=-Ba
OonA nitial Z4F g2E02 coserock-Brishoi=-Ba
OonA nitial ZEE 8509 rinkwater-EBrishois-Eiw
4| | 3

Cancel < Back | Mext = I Einish

The default data format for all fields
is general. If you plan on joining or
relating the report to the soil polygon
layer, select the Mapunit Symbol
(MUSYM) and Mapunit Key
(MUKEY) fields and change them to
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Text Import Wizard - Step 3 of 3

This screen leks wou select each column and set the Daka Format,

—i_olumn data Farmat

MDY -
™ Do not impart column (skip)

Advanced... |

11/5/2012

21X

‘zeneral’ converks numeric values ko numbers, date values ko dates, and all
remaining vwalues ko texk,

~Dakta preview

Conoral

Mritial
frnitial
fhitial
Mnitial

Legend Status

wickenham-Day-Badland
ooserock-Brishois-Ead
ooserock-Brishois-EBad
[rinkwater-EBrisbois—-Ea

5

Ad

[

Zancel < Back Mexk =

| Einish I

5. The data is now imported into Excel and can be sorted or filtered using any of the Excel
functions. It can also be joined to spatial data in ArcMap using the “musym” field.

Area SymiLegend S5t Mapunit S Mapunit K Mapunit  Compone Local Phas Compone Major Con cokey

A B & D
1
2 JODA Initial 102D "28432
3 JODA Initial 140A "s8519
4 |JODA Initial 362E "28540
5 |JODA Initial ah "s8477
6 JODA Initial 333A "a8537
7 |JODA Initial 203C "28530
8 JODA Initial 203D "s8531
5 JODA Initial 124D "s8507
10 JODA Initial 124F "28508
11 JODA Initial 125E "s8509
12 JODA Initial 127E "s8512
13 JODA Initial 127E "s8512
14 JODA Initial 147E "s8524
15 JODA Initial 148C "88525
16 JODA Initial 148D "s8526
17 JODA Initial 145E "s8527
18 [JODA Initial 115 "28497
M A4 b M| FYPORT - Camnanant arnlanical =

3

E F

Gooseroch Bakeoven
Ruckles ve Bakeoven
Barbermil Barbermill
Monroe cl Beeman
Beeman s Beeman
Bingville \ Bingville
Bingville \ Bingville
Gooseroch Brisbois
Gooseroc Brisbois
Drinkwate Brisbois
Brisbois-b Brisbois
Brishois-b Brisbois
Sorf-Brisb Brisbois
Simas-Bri: Brisbois
Simas-Bri: Brisbois
Brisbois-B Brisbois
L\.ﬂcCoin cC Brisbois. n

G

] K

L M N

Compone Ecological Ecological Other Veg O

20 Yes 28482:132 33 RO10XBO05.JD DROUGHTY SHALLOW
7 Mo 88519:132 3
35 Yes 28540:132 172 RO10XBO4: JD DROUGHTY SOUTH <
8 No 88477:132 2
85 Yes 88537132 119 RO10XYOOD:SODIC BOTTOM
85 Yes 88530:132 33 RO10XBOSIJD CLAYPAN 12-16 PZ
85 Yes 88531:132 70 RO10XB0OS:JD CLAYPAN NORTH 12
25 Yes 88507132 30 RO10XB06!JD DROUGHTY CLAYEY M
25 Yes 28508:132 28 RO10XBO6!JD DROUGHTY CLAYEY M
30 Yes 88509:132 58 RO10XB04:JD DROUGHTY CLAYEY S
south 25 Yes 88512:132 11 RO10XB04 JD DROUGHTY CLAYEY S
north 30 Yes 88512:132 13 RO10XBO6!JD DROUGHTY CLAYEY M
25 Yes 88524:132 123 RO10XB04.JD DROUGHTY CLAYEY S
25 Yes 88525:132 2 RO10XBO2:JD SHALLOW 9-12 PZ
25 Yes 88526:132 32 RO10XBO6!JD DROUGHTY CLAYEY M
40 Yes 88527132 52 RO10XEOG! JD DROUGHTY CLAYEY M
orth 5 Ma 88497:132
CaT I I

6. Save the spreadsheet as an xIs or xIsx file type. ArcGIS 9.x only recognizes xls files. ArcGIS 10
recognizes both file types.

7.

The procedure is similar for importing NASIS reports into MS Access. Click on File > Get
External Data > Import, then browse to the NASIS report file. Many different types of file formats
can be imported into Access, including Excel spreadsheets, delimited text files, and dbf files.
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Instructions for Copying Data from NASIS and Pasting it Into
Excel

1. Open NASIS
2. Load data into your selected set
3. Open the NASIS table that you want to copy

¢ In this example, | have opened the component table and | will copy all of the data and
paste it into Excel

_I (2 Nasis ciient Version Number: 6.2.0 JEEEEEEE

@ NASIS Tables Explorer Table Editor Help
%P LYL 90 80-B-r BEH PR ER @O AR ERRER
2o

Lineage Comp %

-:'.l} Project DMU Description « | DMU Rec I | Seq ~ Low | RV ~ | High | Component Name «
- Technical Soil Service ¥ 611036 56132 5 Bluesprin C
£ * 611036 56132 5 Southwick C
- Mapunit - 611036 56132 5 Wilking C
Data Mapunit - 611037 56133 55 Endicott C
. - 611037 56133 30 Bryden C
+ Data Mapunit Certification ... v | 611037 56133 5 Endicott M
+ Data Mapunit Crop Yield v | 611037 56133 5 Oliphant C
+ Data Mapunit Text ¥ | 611037 56133 3 Stember C
[T Site v 611038 56134 50 Endicott C
[T Pedon ~|611038 56134 5 Bryden C
[T Transect v |611038 56134 10 Stember C
[T Site Association v |611038 56134 5 Oliphant C
()1 Area Type ~ 611038 56135 50 Endicott C
(1 Calculation = ~ |611039 56135 35 Oliphant c
[#)T: Distribution Metadata « 611039 6135 5 Alpowa C
I Ecological Site + 611038 56135 5 Bryden C

[+-T: Evaluation

) - 611039 56135 5 Stember C
(¢)+1- Geomorphic Feature Type ¥ | 611040 56136 80 Entic Haploxerolls €
[#)T: Local Plant .

4. Select the rows you want to copy.
e | have selected all rows.

e You can select all rows by clicking Table Editor > Select All Rows, or by clicking Ctrl A
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- e —  r

T Component

— T | -

11/5/2012

Lineage

DMU Description «

DMU Rec ID

Seq ~

Componenl Name =

Local Phase

_----_
| ] s lwikes ] 000000
] ss|  lendew | 000000

| [ | [ 5| [endicott [gravelly substratum |
[ [ s| owhame | 000000
| lstember |
[ sof o lende | 000000
C w7 s B &

5. After you have selected your rows, hit the ctrl key and the C key (Ctrl C) on your keyboard. This
will copy all rows to your clipboard.

6. Open Excel>right click in the Al cell and click paste

A B | ¢ | b [ n | J K L M
DMU Desc DMU Rec | Seq Low RV High Componer Local Phas Taxon Kinc Major Con SIR phase - Low R
612Ag1 112121 70 Agatha series Checked 35
612Ag1 112121 15 Rock outcrop miscellane Checked 35
612Ag1 112121 6 Kettenbach series Unchecked 35
612Ag1 112121 5 Gwin series Unchecked 35
612Ag1 112121 4 Carlinton series Unchecked 15
612Agl,61 578431 75 Agatha series Checked 25
612Ag1,61 578431 10 Gwin series Unchecked 20
612Ag1,61 578431 10 Rock outcrop miscellane Checked 25
612Ag1,61 578431 5 Kettenbach series Unchecked 20
612Bp1 112145 45 Gwin series Checked 35
612Bp1l 112145 40 Kettenbach series Checked 35
612Bp1l 112145 10 Rock outcrop miscellane Unchecked
612Bpl 112145 5 Keuterville series Unchecked 35
612Bp2 112146 45 Kettenbach series Checked 35
612Bp2 112146 30 Keuterville series Checked 35
612Bp2 112146 12 Gwin series Unchecked 35
612Bp2 112146 6 Rock outcrop miscellane Unchecked

e The information in the component table is now pasted into Excel.

¢ Notice that the headers are automatically included when the data is pasted into Excel
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